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अ�याय -4 एमएस-

 
Q.no. 1 मनैअुलमनैअुलमनैअुलमनैअुल ःूेडशीटःूेडशीटःूेडशीटःूेडशीट केकेकेके ःथानःथानःथानःथान

 

Answer: 

(i) मैनुअल ःूेडशीट के �वपर�त, इले�शॉिनक

ूःतिुतया ँहोती ह#। 

 

(ii) मैनुअल ःूेडशीट के �वपर�त, इले�शॉिनक

शैिलय% और लेआउट ह#। 

 

(iii) उनके पास इन�ब*ट +रकै*यएूशन फ़ं�शंस

समायो/जत करते ह#, जो मै1यअुल ःूेडशीट

 

(iv) काय2 क3 गुणव6ा बहुत अिधक है 

सुपा8य है। 

 

(v) यह कं9यूटर िसःटम के फायदे जैसे सट�कता

 

(vi) इले�शॉिनक ःूेडशीट म< डेटा हेरफेर

उदाहरण के िलए, सुौी ए�सेल 2003 

16384 कॉलम और 1048576 पं�>या ँह#।

 

(vii) कं9यटूर म< बड़े मा�यिमक भंडारण 

 

Q.no. 2 काय2प/ुःतकाकाय2प/ुःतकाकाय2प/ुःतकाकाय2प/ुःतका औरऔरऔरऔर काय2पऽककाय2पऽककाय2पऽककाय2पऽक

उ6रउ6रउ6रउ6र: 
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-ए�सेल का उपयोग करके ःूेडशीट

ःथानःथानःथानःथान परपरपरपर इले�शॉिनकइले�शॉिनकइले�शॉिनकइले�शॉिनक ःूेडशीटःूेडशीटःूेडशीटःूेडशीट काकाकाका उपयोगउपयोगउपयोगउपयोग करकेकरकेकरकेकरके कोईकोईकोईकोई भीभीभीभी पांचपांचपांचपांच

इले�शॉिनक ःूेडशीट म< प+रंकृत �वFेषण उपकरण और साथ

इले�शॉिनक ःूेडशीट म< बेहतर संपादन और ूाHपण उपकरण के

फ़ं�शंस ह# जो ःूेडशीट म< प+रवत2न Iकए जाने पर मू*य% को

ःूेडशीट म< कोई भी नह� ंहै। 

 �य%Iक कागज, प<िसल और रबड़ के काम क3 तुलना म< 

सट�कता, उJच गित और बहुमुखी ूितभा लेता है। 

हेरफेर के िलए एक बड़� शीट है। 

2003 म< 255 कॉलम और 65536 पं�>या ँएक ह� शीट म< ह#। Ms Excel 2010 

ह#। 

 उपकरण% का लाभ उठाकर ःवै/Jछक डेटा संमह�त Iकया जाता

काय2पऽककाय2पऽककाय2पऽककाय2पऽक कोकोकोको प+रभा�षतप+रभा�षतप+रभा�षतप+रभा�षत कर<कर<कर<कर< IकIकIकIक उनकेउनकेउनकेउनके बीचबीचबीचबीच �या�या�या�या

I, Aashiyana, Near Sai Temple, Lucknow. 

 

ःूेडशीट 

पांचपांचपांचपांच फायदेफायदेफायदेफायदे िलख<िलख<िलख<िलख<? 

साथ ह� डेटा क3 िचऽमय 

के साथ-साथ �विभ1न 

को ःवचािलत Hप से 

ऐसा काम साफ और 

Ms Excel 2010 म< 

जाता है। 

�या�या�या�या अंतरअंतरअंतरअंतर हैहैहैहै? 
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वक2 शीटवक2 शीटवक2 शीटवक2 शीट कोकोकोको समझनासमझनासमझनासमझना 

Microsoft Excel 2010 फ़ाइल म< काय2पऽक एक एकल ःूेडशीट है /जसम< पं�>याँ और ःतंभ शािमल ह#। 

जब आप पहली बार ए�सेल लॉ1च करते ह# और नीचे Iदए गए Qँय के समान ूःतुत Iकया जाता है, तो 

ःब3न के अिधकांश Iहःसे को Iडफ़ॉ*ट वक2 शीट Tारा िलया जाता है। 

  

 

 

 

 

 

 

यIद आपक3 Excel ूोमाम अभी भी Iडफ़ॉ*ट सेIटंUस का उपयोग कर रह� है, तो आपक3 पहली वक2 शीट का 

नाम Sheet1 है। आपक3 वक2 शीट म< आम तौर पर उन पं�>य% क3 एक ौृखंला होती है, /ज1ह< �वंडो के बाW 

ओर संYयाओ ंके साथ पहचाना जाता है, और कॉलम /ज1ह< �वंडो के शीष2 पर अZर% से पहचाना जाता है। 

यह Excel 2010 म< Iडफ़ॉ*ट सेटअप है, और ूोमाम म< सबसे अिधक उपयोग क3 जाने वाली संरचना है। 

  वक2 बुक को समझना 

Microsoft Excel 2010 म< एक काय2पु/ःतका संपूण2 Excel फ़ाइल है (आमतौर पर एक फ़ाइल ूकार क3 

.xls या .xlsx के साथ पहचानी जाती है)। यIद आप अपने My Documents फो*डर म< ए�सेल फाइल देखते 

ह#, तो वह फाइल एक वक2 बुक है। 

 

 

 

एक नई ए�सेल फाइल म< बकु 1 का Iडफ़ॉ*ट नाम होगा, हालांIक बाद म< जब आप पहली बार फाइल को सेव करते ह# 

तो इसे बदला जा सकता है। आपक3 काय2प/ुःतका म< कई काय2पऽक शािमल हो सकते ह# (Iडफ़ॉ*ट Excel ःथापना म< 

एक नई फ़ाइल म< तीन काय2पऽक ह%गे), साथ ह� फ़ाइल के बारे म< जानकार�, /जसम< मबैोज़, लेखक के नाम, और 
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बहुत कुछ शािमल ह#। लेIकन यहा ंतक Iक अगर आपक3 ए�सेल वक2 बकु म< केवल एक वक2 शीट है, तो उस इकाई को 

अभी भी वक2 बकु कहा जाएगा, िसफ2  इसिलए Iक इसम< अिधक वक2 शीट रखने क3 Zमता है। 

 

ए�सेलए�सेलए�सेलए�सेल म<म<म<म< वक2 शीटवक2 शीटवक2 शीटवक2 शीट औरऔरऔरऔर वक2 बुकवक2 बुकवक2 बुकवक2 बुक केकेकेके बीचबीचबीचबीच अतंरअतंरअतंरअतंर 

शायदशायदशायदशायद एकएकएकएक वक2 शीटवक2 शीटवक2 शीटवक2 शीट औरऔरऔरऔर वक2 बुकवक2 बुकवक2 बुकवक2 बुक केकेकेके बीचबीचबीचबीच केकेकेके अतंरअतंरअतंरअतंर कोकोकोको समझनेसमझनेसमझनेसमझने काकाकाका सबसेसबसेसबसेसबसे आसानआसानआसानआसान तर�कातर�कातर�कातर�का एकएकएकएक IकताबIकताबIकताबIकताब म<म<म<म< 

प\ृ%प\ृ%प\ृ%प\ृ% केकेकेके संदभ2संदभ2संदभ2संदभ2 म<म<म<म< यहयहयहयह सोचनासोचनासोचनासोचना है।है।है।है। 

1. काय2प/ुःतका सपंणू2 पःुतक है, जबIक काय2पऽक उस पःुतक के भीतर एक एकल प\ृ है। 

2. एक वक2 बकु म< कम से कम, एक वक2 शीट हो सकती है, और बहुत अिधक वक2 शीट तक हो सकती है जो केवल 

आपके कं9यटूर पर उपल]ध मेमोर� Tारा सीिमत है। 

3. वक2 शीट को वक2 बकु के भीतर जोड़ा, हटाया या बदला जा सकता है। 

4. आप Iकसी भी वक2 शीट के नाम को ूभा�वत Iकए �बना वक2 बकु का नाम बदल सकते ह#। 

5. आप �वडंो के नीचे शीट टैब पर /�लक करके अपनी वक2 बकु के भीतर वक2 शीट के बीच टॉगल कर सकते ह#। 

Q.no 3 सIबयसIबयसIबयसIबय वक2 शीटवक2 शीटवक2 शीटवक2 शीट समझाइए।समझाइए।समझाइए।समझाइए। 

Answer: 

ए�सेल या Google ःूेडशीट जैसे ःूेडशीट काय2बम% म<, सIबय सेल क3 पहचान रंगीन बॉड2र या सेल के 

आसपास क3 Hपरेखा Tारा क3 जाती है। 

1. सIबय सेल हमेशा सIबय शीट म< होती है। 

2. ए/�टव शीट या करंट शीट ए/�टव सेल वाली वक2 शीट है। सIबय सेल क3 तरह, सIबय शीट पर �यान 

क< Iित Iकया जाता है जब यह एक या एक से अिधक कोिशकाओ ंको ूभा�वत करने वाले काय_ को करने के 

िलए आता है - जैसे Iक ःवHपण - और Iडफ़ॉ*ट Hप से सIबय शीट म< प+रवत2न होते ह#। 

3. सIबय सेल और शीट को आसानी से बदला जा सकता है। सIबय सेल के मामले म<, या तो माउस पॉइंटर 

के साथ Iकसी अ1य सेल पर /�लक करना या क3बोड2 पर एरो क3ज़ को दबाने से दोन% नए सेल सIबय हो 

जाएंगे। 

माउस पॉइंटर के साथ या क3बोड2 शॉट2कट का उपयोग करके एक अलग शीट टैब पर /�लक करके सIबय 

शीट बदल<। 
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Q.no 4 सऽूसऽूसऽूसऽू �या�या�या�या ह#ह#ह#ह# औरऔरऔरऔर वेवेवेवे कैसेकैसेकैसेकैसे

उ6रउ6रउ6रउ6र: 

एक सूऽ एक अिभ`य�> है जो कं9यूटर

ग/णतीय संचालन है। कं9यूटर सॉझटवेयर

उपयोग Iकए जाते ह#, जैसे Iक माइबोसॉbट

से गणना कर सकते ह# और एक ःूेडशीट

नीचे द� गई तःवीर म< एक Microsoft E

कोिशकाओ ंA1, A2, और A3 क3 कुल

 

/ःथरांक/ःथरांक/ःथरांक/ःथरांक औरऔरऔरऔर ऑपरेटर%ऑपरेटर%ऑपरेटर%ऑपरेटर% काकाकाका उपयोगउपयोगउपयोगउपयोग 

Microsoft Excel सूऽ म<, /ःथरांक संYया

करते ह#। /ःथर का उपयोग करके एक
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कैसेकैसेकैसेकैसे बनाएबनाएबनाएबनाए गएगएगएगए ह#ह#ह#ह#? 

कं9यूटर को बताता है Iक �विशd मू*य पर ूदश2न करने

सॉझटवेयर क3 चचा2 करते समय, सूऽ अ�सर ःूेडशीट

माइबोसॉbट ए�सेल। ःूेडशीट म< फ़ामु2ल% का उपयोग करने

ःूेडशीट म< कई कोिशकाओ,ं पं�>य% या ःतंभ% के योग ूाe

Microsoft Excel सूऽ = SUM (A $ 1: A $ 3) का एक

कुल संYया को जोड़ता है। इस सूऽ म<, सूऽ सूऽ का काय2

 

 करकेकरकेकरकेकरके एकएकएकएक सरलसरलसरलसरल ए�सेलए�सेलए�सेलए�सेल सूऽसूऽसूऽसूऽ कैसेकैसेकैसेकैसे बनायाबनायाबनायाबनाया जाएजाएजाएजाए 

संYया, Iदनांक या पाठ मान होते ह#, /ज1ह< आप सीधे

एक सरल ए�सेल सूऽ बनाने के िलए, बस िनfनिल/खत

I, Aashiyana, Near Sai Temple, Lucknow. 

करने के िलए �या 

ःूेडशीट काय2बम% म< 

करने से आप ज*द� 

ूाe कर सकते ह#। 

एक उदाहरण है, जो 

काय2 है। 

सीधे Iकसी सूऽ म< दज2 

िनfनिल/खत कर<: 
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1. एक सेल का चयन कर< जहाँ आप प+रणाम का उgपादन करना चाहते ह#। 

2. बराबर ूतीक (=) टाइप कर<, और Iफर उस समीकरण को टाइप कर< /जसे आप गणना करना चाहते ह#। 

3. अपने सूऽ को पूरा करने के िलए Enter कंुजी दबाएँ। 

यहां ए�सेल म< एक साधारण घटाव फॉमू2ला का उदाहरण Iदया गया है: = 100-50 

सेलसेलसेलसेल संदभ2संदभ2संदभ2संदभ2 काकाकाका उपयोगउपयोगउपयोगउपयोग करकेकरकेकरकेकरके ए�सेलए�सेलए�सेलए�सेल म<म<म<म< सूऽसूऽसूऽसूऽ कैसेकैसेकैसेकैसे िलख<िलख<िलख<िलख< 

अपने Excel सूऽ म< सीधे मान दज2 करने के बजाय, आप उन मान% वाले सेल का उ*लेख कर सकते ह#। 

उदाहरण के िलए, यIद आप सेल A2 म< मान से सेल B2 म< कोई मान घटाना चाहते ह#, तो आप िनfन 

घटाव सूऽ िलख<: A2-B2 

 
 

ऐसा फॉमू2ला बनाते समय, आप सेल के संदभ2 को सीधे सूऽ म< टाइप कर सकते ह#, या सेल पर /�लक कर 

सकते ह# और ए�सेल आपके फॉमू2ले म< संबंिधत सेल संदभ2 डाल देगा। ौणेी संदभ2 जोड़ने के िलए, शीट म< 

कZ% क3 ौणेी का चयन कर<। 

 

 

�यान द<। Iडफ़ॉ*ट Hप से, ए�सेल सापेZ सेल संदभ2 जोड़ता है। Iकसी अ1य संदभ2 ूकार पर /ःवच करने 

के िलए, F4 कंुजी दबाएँ। 

ए�सेल फ़ामु2ल% म< सेल संदभ_ का उपयोग करने का एक बड़ा फायदा यह है Iक जब भी आप संदिभ2त सेल 

म< कोई मू*य बदलते ह#, तो फॉमू2ला आपके ःूेडशीट पर सभी गणनाओ ंऔर फ़ामु2ल% को मै1युअल Hप से 

अपडेट करने के �बना ःवचािलत Hप से पुन: गणना करता है। 

 

Q.no 5 �पवट�पवट�पवट�पवट टेबलटेबलटेबलटेबल कोकोकोको प+रभा�षतप+रभा�षतप+रभा�षतप+रभा�षत कर<कर<कर<कर< औरऔरऔरऔर इसकेइसकेइसकेइसके उपयोगउपयोगउपयोगउपयोग क3क3क3क3 `याYया`याYया`याYया`याYया कर<।कर<।कर<।कर<। 
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उ6रउ6रउ6रउ6र: 

एकएकएकएक �पवट�पवट�पवट�पवट टेबलटेबलटेबलटेबल आपकेआपकेआपकेआपके डेटाडेटाडेटाडेटा काकाकाका एकएकएकएक

जानकार�जानकार�जानकार�जानकार� केकेकेके आधारआधारआधारआधार परपरपरपर +रपोट2+रपोट2+रपोट2+रपोट2 करनेकरनेकरनेकरने

ह#ह#ह#ह# यIदयIदयIदयIद आपकेआपकेआपकेआपके पासपासपासपास लंबीलंबीलंबीलंबी पं�>याँपं�>याँपं�>याँपं�>याँ यायायाया

करनेकरनेकरनेकरने औरऔरऔरऔर आसानीआसानीआसानीआसानी सेसेसेसे करनेकरनेकरनेकरने क3क3क3क3 आवँयकताआवँयकताआवँयकताआवँयकता

�पवट�पवट�पवट�पवट टेबलटेबलटेबलटेबल कैसेकैसेकैसेकैसे बनाएंबनाएंबनाएंबनाए ं

1. अपनाअपनाअपनाअपना डेटाडेटाडेटाडेटा पं�>य%पं�>य%पं�>य%पं�>य% औरऔरऔरऔर ःतंभ%ःतंभ%ःतंभ%ःतंभ% क3क3क3क3

2. एकएकएकएक �विशd�विशd�विशd�विशd �वशेषता�वशेषता�वशेषता�वशेषता TाराTाराTाराTारा अपनेअपनेअपनेअपने डेटाडेटाडेटाडेटा

3. अपनीअपनीअपनीअपनी धरु�धरु�धरु�धरु� तािलकातािलकातािलकातािलका बनानेबनानेबनानेबनाने केकेकेके िलएिलएिलएिलए

4. "पं�>पं�>पं�>पं�> लेबललेबललेबललेबल" ZेऽZेऽZेऽZेऽ म<म<म<म< एकएकएकएक फ़3*डफ़3*डफ़3*डफ़3*ड कोकोकोको

5. IकसीIकसीIकसीIकसी फ़3*डफ़3*डफ़3*डफ़3*ड कोकोकोको "मानमानमानमान" ZेऽZेऽZेऽZेऽ म<म<म<म< खींच<खींच<खींच<खींच<

6. अपनीअपनीअपनीअपनी गणनागणनागणनागणना ठiकठiकठiकठiक-ठiकठiकठiकठiक कर<।कर<।कर<।कर<। 

 

उदाहरणउदाहरणउदाहरणउदाहरण 

Insert a Pivot Table 

 

To insert a pivot table, execute the following steps.

1. Click any single cell inside the data set.
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एकएकएकएक सारांशसारांशसारांशसारांश हैहैहैहै, /जसे/जसे/जसे/जसे एकएकएकएक चाट2चाट2चाट2चाट2 म<म<म<म< पैकपैकपैकपैक IकयाIकयाIकयाIकया गयागयागयागया हैहैहैहै जोजोजोजो

करनेकरनेकरनेकरने औरऔरऔरऔर jझान%jझान%jझान%jझान% काकाकाका पतापतापतापता लगानेलगानेलगानेलगाने देतादेतादेतादेता है।है।है।है। �पवट�पवट�पवट�पवट टेबलटेबलटेबलटेबल �वशेष�वशेष�वशेष�वशेष

यायायाया कॉलमकॉलमकॉलमकॉलम ह#ह#ह#ह# जोजोजोजो मान%मान%मान%मान% कोकोकोको पकड़तेपकड़तेपकड़तेपकड़ते ह#ह#ह#ह# /ज1ह</ज1ह</ज1ह</ज1ह<  आपकोआपकोआपकोआपको एकएकएकएक

आवँयकताआवँयकताआवँयकताआवँयकता है।है।है।है। 

क3क3क3क3 ौणेीौणेीौणेीौणेी म<म<म<म< दज2दज2दज2दज2 कर<।कर<।कर<।कर<। 

डेटाडेटाडेटाडेटा कोकोकोको सॉट2सॉट2सॉट2सॉट2 कर<।कर<।कर<।कर<। 

िलएिलएिलएिलए अपनीअपनीअपनीअपनी कोिशकाओंकोिशकाओंकोिशकाओंकोिशकाओ ंपरपरपरपर ूकाशूकाशूकाशूकाश डाल<।डाल<।डाल<।डाल<। 

कोकोकोको खींच<खींच<खींच<खींच< औरऔरऔरऔर छोड़<।छोड़<।छोड़<।छोड़<। 

खींच<खींच<खींच<खींच< औरऔरऔरऔर छोड़<।छोड़<।छोड़<।छोड़<। 

, execute the following steps. 

1. Click any single cell inside the data set. 

I, Aashiyana, Near Sai Temple, Lucknow. 

जोजोजोजो आपकोआपकोआपकोआपको आपक3आपक3आपक3आपक3 

�वशेष�वशेष�वशेष�वशेष HपHपHपHप सेसेसेसे उपयोगीउपयोगीउपयोगीउपयोगी 

एकएकएकएक दसूरेदसूरेदसूरेदसूरे क3क3क3क3 तुलनातुलनातुलनातुलना 
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2. On the Insert tab, in the Tables group, click PivotTable.

 

The following dialog box appears. Excel automatically 

new pivot table is New Worksheet. 

3. Click OK. 

Sort 
To get Banana at the top of the list, sort the pivot table.

1. Click any cell inside the Sum of Amount column.

2. Right click and click on Sort, Sort L

Result After sorting is given below

Filter 
Because we added the Country field to the Filters area, we can filter this pivot table by Country. For 

example, which products do we export the most to France?

1. Click the filter drop-down and select France.

Result. Apples are our main export product to France.
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2. On the Insert tab, in the Tables group, click PivotTable. 

 

The following dialog box appears. Excel automatically selects the data for you. The default location for a 

 

To get Banana at the top of the list, sort the pivot table. 

1. Click any cell inside the Sum of Amount column. 

2. Right click and click on Sort, Sort Largest to Smallest. 

 

After sorting is given below 

 

Because we added the Country field to the Filters area, we can filter this pivot table by Country. For 

example, which products do we export the most to France? 

and select France. 

Result. Apples are our main export product to France. 

I, Aashiyana, Near Sai Temple, Lucknow. 

selects the data for you. The default location for a 

Because we added the Country field to the Filters area, we can filter this pivot table by Country. For 
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Note: you can use the standard filter (triangle next to Row Labels) to only show the amounts of specific 

products. 

Q.no 6 ए�सेलए�सेलए�सेलए�सेल म<म<म<म< ऑटोऑटोऑटोऑटो योगयोगयोगयोग �या�या�या�या हैहैहैहै? 

उ6रउ6रउ6रउ6र: 

AutoSum सु�वधासु�वधासु�वधासु�वधा SUM काय2पऽककाय2पऽककाय2पऽककाय2पऽक फ़ं�शनफ़ं�शनफ़ं�शनफ़ं�शन काकाकाका उपयोगउपयोगउपयोगउपयोग करकेकरकेकरकेकरके पं�>य%पं�>य%पं�>य%पं�>य% औरऔरऔरऔर ःतंभ%ःतंभ%ःतंभ%ःतंभ% कोकोकोको कुलकुलकुलकुल करनाकरनाकरनाकरना बहुतबहुतबहुतबहुत 

आसानआसानआसानआसान बनातीबनातीबनातीबनाती है।है।है।है। 

मानकमानकमानकमानक टूलबारटूलबारटूलबारटूलबार परपरपरपर एकएकएकएक �वशेष�वशेष�वशेष�वशेष कमांडकमांडकमांडकमांड बटनबटनबटनबटन हैहैहैहै जोजोजोजो आपकोआपकोआपकोआपको बहुतबहुतबहुतबहुत ज*द�ज*द�ज*द�ज*द� एसयूएमएसयूएमएसयूएमएसयूएम फ़ं�शनफ़ं�शनफ़ं�शनफ़ं�शन डालनेडालनेडालनेडालने क3क3क3क3 अनुमितअनुमितअनुमितअनुमित 

देगा।देगा।देगा।देगा। 

इसइसइसइस कमांडकमांडकमांडकमांड बटनबटनबटनबटन कोकोकोको AutoSum बटनबटनबटनबटन केकेकेके HपHपHपHप म<म<म<म< जानाजानाजानाजाना जाताजाताजाताजाता है।है।है।है। 

 

Step: 1. Click on Home button 

 2. Click on Auto sum button in Editing Group. 
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आप सॉप-डाउन मेन ूका �वःतार करके

कर सकते ह#। 

"अिधक फ़ं�शंस" बटन डायलॉग बॉ�स

आप आस1न कोिशकाओं को ज*द�

सकते ह#। 

Q.no 7 ए�सेलए�सेलए�सेलए�सेल सॉट2सॉट2सॉट2सॉट2 औरऔरऔरऔर Iफ़*टरIफ़*टरIफ़*टरIफ़*टर

 

Answer: 

सॉIटlग टूल आपको Iदनांक, संYया, 

िनfनिल/खत उदाहरण म<, हम छंटाई

तकनीक Iदखाएंगे। 

As you can see, the order dates, order numbers, prices, etc. are all out of order. 

Sorting Data 

Let’s say you had the spreadsheet above and wanted to sort by price. This process is fairly 

simple. You can either highlight the whole column or even click on the first cell in the column to 

get started. Then you will: 

1. Right click to open the menu

2. Go down to the Sort option 

3. Click on Largest to Smallest

4. Select Expand the selection

5. Click OK 

 

Filtering Data 
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करके AVERAGE, COUNT, MAX या MIN फ़ं�शन

बॉ�स डाल< (डाल<)। 

ज*द� से योग करने के िलए शॉट2कट कंुजी (Alt + =) का

Iफ़*टरIफ़*टरIफ़*टरIफ़*टर �या�या�या�या हैहैहैहै? 

, अ*फ़ाबेIटक ऑड2र और अिधक Tारा सॉट2 करने क3

छंटाई और छानने के उपयोग का पता लगाएंगे और कुछ

 

As you can see, the order dates, order numbers, prices, etc. are all out of order.  

Let’s say you had the spreadsheet above and wanted to sort by price. This process is fairly 

ou can either highlight the whole column or even click on the first cell in the column to 

Right click to open the menu 

Go down to the Sort option – when hovering over Sort the sub-menu will appear

Click on Largest to Smallest 

Select Expand the selection 

I, Aashiyana, Near Sai Temple, Lucknow. 

फ़ं�शन को ज*द� से दज2 

का उपयोग भी कर 

क3 अनुमित देता है। 

कुछ उ1नत छंटाई 

 

Let’s say you had the spreadsheet above and wanted to sort by price. This process is fairly 

ou can either highlight the whole column or even click on the first cell in the column to 

menu will appear 
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The filter feature applies a drop down menu

specific choices to narrow a table. Using the above example, let’s say you wanted to filter your 

table by Company and Salesperson. Specifically, you want to find the number of sales Dylan 

Rogers made to Eastern Company.

To do this using the filter you would:

1. Go to the Data tab on Excel ribbon

2. Select the Filter tool 

3. Select Eastern Company from the dropdown menu

4. Select Dylan Rogers from the Salesperson dropdown menu

 

ूm।ूm।ूm।ूm। 8 आपआपआपआप ए�सेलए�सेलए�सेलए�सेल म<म<म<म< वक2 बकुवक2 बकुवक2 बकुवक2 बकु
Answer: 

Insert a worksheet 

• Select the    plus icon at the bottom of the screen.

• Or, select Home > Insert 

Delete a worksheet 

• Right-click the Sheet tab and select

• Or, select the sheet, and then select
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The filter feature applies a drop down menu to each column heading, allowing you to select 

specific choices to narrow a table. Using the above example, let’s say you wanted to filter your 

Company and Salesperson. Specifically, you want to find the number of sales Dylan 

Rogers made to Eastern Company. 

To do this using the filter you would: 

Go to the Data tab on Excel ribbon 

Select Eastern Company from the dropdown menu 

Select Dylan Rogers from the Salesperson dropdown menu 

वक2 बकुवक2 बकुवक2 बकुवक2 बकु सेसेसेसे शीटशीटशीटशीट कैसेकैसेकैसेकैसे डाल<गेडाल<गेडाल<गेडाल<गे औरऔरऔरऔर िनकाल<गेिनकाल<गेिनकाल<गेिनकाल<गे? 

plus icon at the bottom of the screen. 

 > Insert Sheet. 

 

tab and select  Delete. 

Or, select the sheet, and then select Home > Delete > Delete Sheet. 

I, Aashiyana, Near Sai Temple, Lucknow. 

to each column heading, allowing you to select 

specific choices to narrow a table. Using the above example, let’s say you wanted to filter your 

Company and Salesperson. Specifically, you want to find the number of sales Dylan 
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Q.no 9 ःूेडशीटःूेडशीटःूेडशीटःूेडशीट ूोमामूोमामूोमामूोमाम केकेकेके IकसीIकसीIकसीIकसी
Answer: 

एक फ़ं�शन एक पूव2िनधा2+रत सूऽ है

है। सभी ःूेडशीट काय2बम% म< सामा1य

िलए योग, औसत, गणना, अिधकतम

 

 

 

 

 

 

 

 

 

काय_काय_काय_काय_ काकाकाका उपयोगउपयोगउपयोगउपयोग करनाकरनाकरनाकरना 

�विभ1न ूकार के काय2 ह#। यहां आपके

1. SUM: यह फ़ं�शन तक2  म< कोिशकाओं

2. AVERAGE: यह फ़ं�शन तक2  म<

योग क3 गणना करता है और Iफर तक2

3. COUNT: यह फ़ं�शन तक2  म< संYयाgमक

सेल ौणेी म< आइटम% को ज*द� से िगनने

4. अिधकतम: यह फ़ं�शन तक2  म< शािमल

5. 1यूनतम: यह फ़ं�शन तक2  म< शािमल
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IकसीIकसीIकसीIकसी भीभीभीभी 5 काय_काय_काय_काय_ कोकोकोको प+रभा�षतप+रभा�षतप+रभा�षतप+रभा�षत करताकरताकरताकरता है।है।है।है। 

है जो एक �वशेष बम म< �विशd मू*य% का उपयोग करके

सामा1य काय2 शािमल होते ह# /जनका उपयोग कई ूकार

अिधकतम मू*य और 1यूनतम मू*य को खोजने के िलए Iकया

आपके Tारा उपयोग Iकए जाने वाले कुछ सामा1य काय2 

कोिशकाओ ंके सभी मू*य% को जोड़ता है। 

म< शािमल मू*य% के औसत को िनधा2+रत करता है। 

तक2  म< कोिशकाओ ंक3 संYया से उस मू*य को �वभा/जत

संYयाgमक डेटा वाली कोिशकाओ ंक3 संYया को िगनाता

िगनने के िलए उपयोगी है। 

शािमल उJचतम सेल मान को िनधा2+रत करता है। 

शािमल सबसे कम सेल मान को िनधा2+रत करता है। 

I, Aashiyana, Near Sai Temple, Lucknow. 

करके गणना करता 

ूकार क3 कोिशकाओं के 

Iकया जा सकता है। 

 Iदए गए ह#: 

 यह कोिशकाओ ंके 

�वभा/जत करता है। 

िगनाता है। यह फ़ं�शन 


